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PROGRAMMING A LOGIC DIAGRAM Programming the software

1/ Programming the software.

The software can be installed in one of the five available languages (English, German,
French, Italian, Spanish).

1.1/ Application 1 : Access management — Automation of a gate.

This section will deal with an example of automation of a gate as shown in figure 1.1.

< Closing (02) Opening (O1) >

Movement
detector (14)

IIIIIIIi

mem \r.r
Limit switches g/llroet;rl c‘)’:}'stgftwo
Closed (12) Open (13) rotation: O1
and O2
AN
@ Remote control signal : 11
Fig. 1.1 Automation of a gate (schematic diagram)
Operation : =>|f the gate is closed or partially open, the remote control signal causes the

gate to open fully unless another remote control signal is activated.

=>If the gate is open, it starts to close after 4 seconds unless the movement
detector is activated.

=>»During closing, the gate opens fully if the movement detector is activated.
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PROGRAMMING A LOGIC DIAGRAM

Programming the software

easily and intuitively.

Remote control (pulse) 11

Limit switch closed

Limit switch open I3

Movement detector
14

The logic diagram which corresponds to this type of operation (figure 1.2) can be deduced

Fig. 1.2 Logic diagram of automation of a gate.

1.1.1/ Fast and easy programming.

OPEN
¢ > >1 TIMER
=1 | Memory | >
el l yes—> & Plor | Set/Reset Delay
»| AND Priority reset
@
L CLOSE
» Memory TIMER
» Set /Reset ™| Delay
> >1 Priority reset
r » OR

Before starting programming, the following two steps should be performed :

->Make alist of the number of inputs and outputs to be used.

OUTPUTS
01 | Gate opening
02 |Gateclosing

=>Launch the application and select amodule (4-2 ; 6-4 or 12-8), seefigure 1.3.

INPUTS
|1 | Remote control signa
12 | Limit switch closed
I3 | Limit switch open
14 | Movement detector
O] Crouzet

AUTOMATISMES




PROGRAMMING A LOGIC DIAGRAM

Programming the software

The example shown requires a module with 4 inputs and 2 outputs.

£ CROUZET Logic Software
File Controller Com  Help

= R E A =

Select Controller Type

& 4 Input and 2 Dutput

€ 12 Input and & Dutput

Help

B Input and 4 Output Cancel |

Fig. 1.3 Selecting the number of inputs and outputs.

->Sdect the IN key to define the type of inputs to be
inserted in the diagram (figure 1.4).

=>Choice of inputs (figure 1.5) :

Note: If necessary, use the dider indicator (scroll bar) to access the
complete list of inputs.

1-Place the mouse cursor on the required icon
(pushbutton).

2-Click once with the left mouse button. The mouse pointer
will display a cross on the workscreen (or FBD: Function
Block Diagram) if the selection is correct.

Slider indicator (scroll bar) offering
accessto all the available elements.
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PROGRAMMING A LOGIC DIAGRAM Programming the software

3-Position the cross in one of the empty boxes numbered 101 to 104.
A
L |
old| |
E E 102

= TS |

Fig. 1.6 Sep 4
4-Click oncein this zone to complete the entry.

I
ZA 1|:|1
1|:|2

=
°lA

Fig. 1.7 Sep 5
5-Repeat operations 1, 2, 3 and 4 to place the three other inputs shown below :

Position contactor : ;

Position contactor :

Proximity switch :

g [

The screen obtained is as follows (figure 1.8) :

& CROUZET Logic Software - Untitled.vcs - [FBD] M= E3
G File Edt Yiew Insert Tools Search Controller Com Option ‘Window Help =18l =]
nlzlE] |- [els]e el = | =] »iw) ) sis](o(o] (=] o]
[ 3 FED TITLE

[T

IEI2
103

-
=0

B
u
74 101
o
"1
%

Fig. 1.8 Inputsin place.
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PROGRAMMING A LOGIC DIAGRAM Programming the software

=>Select the OUT key to define the type of outputs to be |
used (figure 1.9). H_.

NECT
=mar

Fg. 1.9
- &
=> Choice of outputs (figure 1.10) : i _@_
The procedure is exactly the same as that for inputs. The motor
with two directions of rotation will be assimilated by two separate
outputs. =
The diagram is asfollows (figure 1.11) : > E%
ﬂ =4
FED TITLE Fig. 1.10
I01
Ioz
I03
I04
Fig. 1.11 The inputs and outputs are positioned.
=>Choice of functions: * |_ogic functions are accessed | %H
viathe LOGI menu (figure 1.12). ﬂc T,
Fig. 1.12
* More advanced functions [THL |0
(function blocks) are accessed viathe FUNC menu (figure 1.13). ﬂ £ ¥
1
Fig. 1.13

=>Positioning the blocks.

[INote : Selecting the blocks is similar to selecting the inputs/outputs.
If a block is positioned too close to the limits of the working window (F.B.D.), an error
message will appear.
It is possible to extend the window. To do this, place the pointer on one of the edges
of the F.B.D. and, holding down the left-hand button, move the window.

1-Select an AND logic block from the LOGI menu (logic functions, figure 1.14).
2-Place thisinthe F.B.D.

,—— | AND block
A;J
D

EQME LEU
B R N

Fig. 1.14
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PROGRAMMING A LOGIC DIAGRAM Programming the software

3-Place one OR logic block, then another.

4-Place aNOT logic block.

6-Place one DEL AY function block, then another.
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PROGRAMMING A LOGIC DIAGRAM Programming the software

=>Make the connections.

| Titre Fod |

Fig. 1.16 Arrangement of blocks before connection.

Connection rules:

Connections are made from the output of one block to the input of
another block.

An output can be connected to several inputs.

An input can only be connected to a single output.

For successful connection, the mouse pointer must be correctly
positioned on the special marks.

VVV VY

Discrete inputs — > JTIM <4— Analogue output

Discrete output

» An analogueue output (or input) cannot be linked to a discrete input (or
output).
» Connection isonly possible if the corresponding mode is activated.

l’T[} Wiring connections
S}
T

» Removing a connection : Click on it with the left-hand button then press
Delete on the keyboard or select Clear from the drop-down Edit menu.

1-Activate wiring mode (see above): the icon is highlighted.

2-Place the mouse cursor on the 1 1 output, keeping the left-hand button pressed.
3-Drag the pointer to one of the inputs on the OR block (B02) (figure 1.17).
4-Rel ease the mouse button (see figure 1.18 or 1.19).

Fig. 1.17 Connection in progress. Fig. 1.18 Connection complete.

S| Crouzet
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PROGRAMMING A LOGIC DIAGRAM Programming the software

CROUZET Logic Software

X

Fig. 1.19 Error message: the connection has
not been made. Repeat steps 2, 3, 4.

5-Repeat the operation to link 12 to the input on the NOT block (B04), and to one of the
inputs on the OR block (BO3).

€T |n
[EEET|

6-Connect 13 to the SET input on the SET/RESET block (B06), then to the RESET input
on the SET/RESET block (B05).

S| Crouzet 10
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PROGRAMMING A LOGIC DIAGRAM Programming the software

9-Connect the output on the AND block (B01) to one of the inputs on the OR block (B02).

10-Connect the output on the OR block (B02) to the SET input on the SET/RESET block
(B05), then to one of the inputs on the OR block (BO3).

&}
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PROGRAMMING A LOGIC DIAGRAM Programming the software

14-Connect the output on the SET/RESET block (B06) to the discrete input on the DELAY block (BOS).

16-Reposition the blocks to make the diagram clearer, figures 1.20 and 1.21 (see General
remarks on the following page).

Block in the
process of
being moved.

Fig. 1.20

Apcess mamagement - Sotomation of agpte

Closed 1 - E B0

LY [ %7

Muvt . Det.
104

Fig. 1.21 Reorganized F.B.D.
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PROGRAMMING A LOGIC DIAGRAM Programming the software

General remarks:: - In order to make the diagram clearer, it is possible to reorganize the
elements of the F.B.D. (blocks, connection cables, inputs, outputs). To do
this, click on the element to be moved and, holding down the left mouse
button, place it in the desired position.

- To move an input or an output, the mouse pointer should be positioned on
the black mark above theicon. A vertical arrow will then appear.
- Comments can aso be added to each block or in the F.B.D. title by

Movement
indicator.

double-clicking on the element in question. For example, show the action
associated with output O1 (figure 1.22) :

Activating/Deactivating
the comment.

Cormmerit

Openihg Opening

o0l o0l
-EI [» » ¥ Display Comment » @ P

| [izplay Sigral Humter

] Cancel Help |

Fig. 1.22 Adding a comment.

- Each of the blocks is numbered by default. This option can be inhibited by
deactivating the corresponding item.

Set/Reset I

o . Comment
Activating/Desactivating

the block number.

v [Dizplay Comment

V& | Eo4 » I™ Display Signal Number ; N |
| ST [v¥ Display Monitor Information | REET
— Pricrity
Set priority

Activating/Deactivating | =
data on the logic state of
the function being
simulated.

k. Cancel Help

Fig. 1.23 Options for a SET/RESET function block.
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->Setting the parameters for the DELAY and SET/RESET functions.

1-Double-click on the DELAY function block (B0O7) to call up the dialogue box associated

with the block.

2-1n the On Operation Delay field, enter 5 (5 x 100ms = 5 tenths of a second, to stop the

gate between the opening phase and the closing phase).
3-In the Off operation Delay field, enter O.

Delay

Cormment

¥ Display Comment

Delay

LCamment

¥ Dizplay Comment

¥ Display Signal Mumber
¥ Display Monitor [nformation

— On Operation Delay
|

_

% 100msz
0 2767

— Off Operation Delay
|

_

% 100ms

y

[0 ta 32767]

[Etiange Eurent Yalues

0k I Cancel Help

Ll

{

v Dizplay Sign
v Dizplay Maonitar Information

— On Operation Delay
|
| % 100ms
(05D 22767)
— Off Operation Delay
1
| < d % 100ms
)

[EhangelEurment Ealuey
; T Cancel | Help |

4-Confirm by pressing OK.

5-Double-click onthe DELAY function block (B08).

6-1n the On operation Delay field, enter 40 (40 x 100ms = 4 seconds to stop the gate

opening completely).

7-1n the Off operation Delay field, enter O.
8-Confirm by pressing OK.

Delay

Cormment

¥ Display Comment

Delay

Comment

¥ Display Comment

¥ Display Signal Mumber
¥ Display Monitor [nformation

\

— On Operation Delay
|

_

% 100msz
'to 32767)

— Off Operation Delay
|

_

y

% 100ms
[0 to 32767

[Etiange Eurent Yalues

Ok I Cancel

{

Help

v Dizplay 5
¥ Dizplay Monitor Infarmation

— On Operation Delay

. e
| % 100ms
0o 32767)

— Off Dperation Delay

il \ % 100ms

| il 32767)

Charge Current Ealuy

Cancel |

Help
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PROGRAMMING A LOGIC DIAGRAM Programming the software

9-Double-click on the SET/RESET function block (B05).
10-In the Priority field, check that the option Initialize the priority (Reset priority) is
checked.

Set/Rezet |

Comment

¥ Display Comment

¥ Display Signal Mumber

¥ Display Monitar Information

Fricrity

k. Canicel Help

11-Confirm by pressing OK.

EI | Start/Stop Simulation icon for starting the simulation.

12-Repeat steps 9, 10, 11 with the SET/RESET function block (B06).

=> Start simulation using theicon in the toolbar.
Simulation consists of clicking on the inputs to recreate the operating conditions.

S| Crouzet 1

AUTOMATISMES



PROGRAMMING A LOGIC DIAGRAM Programming the software

1.1.2/ DISPLAY mode.

The DISPLAY block in the FUNCTION menu (figure 1.24) creates a true Man
Machine Interface (M.M.1.).

In certain conditions (signals given by inputs), it is possible to display process
monitoring messages on a screen.

DISPLAY
function.

Fig. 1.25 Scale modification
drop-down menu

Fig. 1.24
=>»Enlarge the working window if it istoo small (it is also possible to reduce the scale of the

project by changing the ZOOM - (figure 1.25).
=>Arrange the DISPLAY functions as shown in figure 1.26.

Femcote control

E Operirg
f fa = o
EL INZDENTRY
Closed positio

E=r

@ Closing
RE SEfT] 'L@ @ Ei] ooz
i

DINGOELRY,

Fig. 1.26 Adding DISPLAY functions. This block enhances the M.M.I.

The E block isan internal bit which executes forcing to 1. It enables a message to be continuously

displayed on the LCD screen of the module. It is accessed viathe IN menu using the scroll bar (up
and down arrows).
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PROGRAMMING A LOGIC DIAGRAM Programming the software

=> Setting the function parameters.

Display [ %] Display [1x]
E10 |B11 | Bio BN |
—LComment———— UserOption————— —LComment——— UserOpton——————————
I I " Sting I
; 1 Date
¥ Display Commet ¥ Display Comment & Time
[V Display Signal Nurmber V| Special Key v Display Signal Mumber ¥ Special key
[V Display Manitar Infarmation ~ Display Bt ¥ Display Monitor Information Display Fatia
— Starting position of Text = 14 .  Starting position of Text ﬁ 11
/0 - 1410
H= |1 #= |6
/100 S
=3 SIS N — | y-[4 ) (/1000 3
Ok I oK I
d 4 . m B . Yy u oy y Cancel | d d . n n . u u uyu u Cancel |
h h & n H
Help | Help |

Double-click on block B10 then block B11. The menu shown in figure 1.27 will appear.

Fig. 1.27 Window for setting the parameters of DISPLAY functions. Screens displayed simultaneously appear in the
same window. Each screen can be accessed by the corresponding tab. The text of the active block is shown in red. So,
block B10 will display the current date (User option) on line Y=3 of the display. Smilarly, block B11 will display the
current time in X=6 and Y=4. In this way the messages are not superimposed.

The other two blocks, B12 (figure 1.28) and B13 (figure 1.29), show the action performed

Display [1X] Display [ x]
B12 | B13 |
LComment———————————— UserOption————— LComment—————— ~User Oplion
I £+ Stiing IDpening I ¥ Shing ICIosing
© Date " Date
¥ Dizplay Comment C Time ¥ Dizplay Comment ® T
¥ Display Signal Number [V | SpeciEl ey Iv Display Signal Mumber [¥ | Special ey
¥ Display Monitor Information (7012, o ¥ Display Monitor Information (o200 F 2o
Starting pozition of Test & |/ Starting position of T et % /1
110 o el
ol /100 2= ¢ /100
y= [ ! 1l/1000 I—L, y= [ 1 /000 I—Ll
0 p e n i n g u] I C 1 o & i n g Ok I
Cancel | Cancel |
Help | Help |

(opening or closing).

Fig. 1.28 Text is displayed (String option checked in the User option menu) by entering characters (restricted to 10 per
line) in the entry field in this option. The alphanumerical string can then be positioned using its X and Y coordinates.
This block is connected to the output which activates opening of the gate.

Fig. 1.29 This block is connected to the output which activates closing of the gate.

The Opening and Closing texts can have the same coordinates since activation of the corresponding
screens is subject to two mutually exclusive conditions (i.e. the gate cannot open and close at the
sametime).

S| Crouzet o
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PROGRAMMING A LOGIC DIAGRAM Programming the software

=>»n the menu bar, select the Window drop-down menu, then the Tile option (figure 1.30).

Wfindow

Cazcade

1 Monitaring in Spstem Sketch
v 2 FBD

Fig. 1.30

=» Start the simulation using the Start/ Stop Simulation button.
=>A dialogue box (figure 1.31) offers to display the screen during simulation. Press Yes to
display the interface.

Inzert Special LCD Image |

Dizplay Function iz present in FED. Do pou want to inzert Special object in
kanitoring in System Sketch window to zee Controller LED contents™

[T Do not dizplay this dialog bos again

Mo Help

Fig. 1.31 Sart of simulation with LCD screen display.
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PROGRAMMING A LOGIC DIAGRAM Programming the software

1.2/ Application 2 : School bell.

A school wishes to install a clock which is capable of managing when bells ring during the school
day, including holidays and bank holidays.

The specifications are shown below.

The bell should ring for 3 seconds, Monday to Friday at the following times:

Breaks Classes
Morning Afternoon
0755 } 1355 }
0800 } 1400 }
0850 } 1450 }
0855 } 1455
0945 1545 }
10 minutes recreation 10 minutes recreation
0955 } 1555 }
1000 } 1600 }
1050 } 1650 }
1055 } 1655
1145 1745 }

However, it should not ring during school holidays or on bank holidays :
The exampleis based on the French holidays for 1999.

School holidays (1999)
Christmas . afternoon 18 December 98 to morning 4 January 99.

Winter . afternoon 12 February 99 to morning 1 March 99.
Easter . afternoon 09 April 99 to morning 26 April 99.
Summer . afternoon 30 June 99 to morning 6 September 99.

Hallowe'en : afternoon 29 October 99 to morning 8 November 99.
Bank holidays (including those in the school holidays)

1 January (New Y ear’s Day)

1st Monday in April (Easter Monday)

1 May (Labour Day)

8 May (VE day)

2nd Thursday in May (Ascension)

4th Monday in May (Pentecost)

14 July (Bastille Day)

15 August (Assumption)

11 November (Armistice Day)

25 December (Christmas)

Two TIME SWITCH (Clock) functions will be employed. One will manage the daily
ringing of the bell, the other will switch the system off during the holidays. A ONE SHOT function
will set the duration of the bell.

S| Crouzet 1
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PROGRAMMING A LOGIC DIAGRAM Programming the software

The logic diagram is shown below (figure 1.32) :

Clock
(Time Switch) N ON E Bell
Dailv activation. AND E— SHOT —»
Duration of bell set
CI OCk at 3 seconds.
(Time Switch) | N OT

Deadtivation durina holidavs

Fig. 1.32 Logic diagram for a school bell.

The steps for selecting and positioning the blocks will be less detailed than for the previous
example. Refer back in case of difficulty.

A module with 4 inputs and 2 outputs will be sufficient for this example.

The output (bell) will be represented by an icon of a lamp in order to clearly identify
activation during the simulation.

1.2.1/ Positioning the blocks.

=>After opening a new file, taking care to select a 4/2 module, enter the title of the program
to be executed by double-clicking on the Fbd title window (figure 1.33).

FED TITLE
J
window enter.
Fhd title. 1o
or FBL ; X
102 Sechool bel )
Dialogue box
obtained by double-
clicking on Fbd
title. 103 KN =
104 ak Cancel | Help |
Fig. 1.33
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PROGRAMMING A LOGIC DIAGRAM Programming the software

->Select alamp from the OUT menu to place in one of the dots reserved for outputs (figure
1.34).

‘Sd’molbell

Lamp

Fig. 1.34

=>Using the LOGI menu, place an AND block then aNOT block in the work screen (figure
1.35). It is possible to include a comment on the output.

'!4 ﬂ% ‘deolbe]l |

->Using the FUNC menu, select one ONE SHOT block function and 2 TIMESW function
blocks (figure 1.36). Use the scroll bar to access one or other of these functions.

m% ‘deolbe].l |
=B :

|| Crouzet 21
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PROGRAMMING A LOGIC DIAGRAM Programming the software

=>Create the wiring (figure 1.37). To do this, activate the wiring mode.

Schoolbell

Wring connections

10l
| &

ool
I |:|2 _|_|HE._.H|_|T|

Ios

OEIE

104

Fig. 1.37

\ Note : Arrange the blocks and connections so that the diagram is as clear as possible.

1.2.2/ Positioning the blocks.

The parameters for the ONE SHOT blocks (3-second pulse signal) and TIME SWITCH blocks
(hourly, daily, monthly clock) must now be set.

=>Double-click on the ONE SHOT function block. A dialogue box (figure 1.38) prompts
you to enter the length of the signal corresponding to the time of the bell.
=>Enter the value 30 (30x100ms = 3 3).

Press the Details button in the One Shot dialogue box, and ensure that the None option has been
checked (figure 1.39).

OneShot [ x| |
LComment

[+ Display Comment

: : Indication of the
¥ Display Signal Mumber / signal length. The

¥ Display Manitor Information maximum permitted

Movethe .
cursor to enter Sagtrol Time ‘ valueis 32767

. . : (which is approx.
aduration of — [0 32767x100ms=54
upto 10 : { % 100ms -
seconds (0 ta 32767) min 36 sec)
(100x100ms)
[Starae Eument alie Dietails
] Cancel Help
Fig. 1.38
| Crouzet] 22
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e

— Comment

[+ Display Comment

¥ Display Signal Mumber
¥ Display Manitor Information

Cantral Time OneShot Details [ X |
= a0
: I # 100ms — Output Clear Candition

[0 to 32767 S .

& HNone
Ehange Cument Yalle @ " wihen Input i OFff
] Cancel Help
0k, Cancel Help

Fig. 1.39

Confirm all entries by pressing OK.

=>Specify which should be the parameters of the 2 clock functions.

Thefirst clock deals with the time the bell is activated.
Double-click on the Time Switch connected directly to the AND block (numbered B0O4 in

the example in this document). The dialogue box associated with it (figure 1.40) accesses several

menus.
Time Switch
— Comment
I v Dizplay Sigral Mumber
[+ Display Comment ¥ Display Moritor [ nformation
— Programming
line.
||
Diaylight Saving Time
OpendMew | Delete | Curent Time | Summer Time | ‘*
0K I \ Cancel |f Help |
A [
Accessto Deletea J { Transfers the data Summer time
programming programming concerning time and selection
options. line. date to the module. mode.
Fig. 1.40

23
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PROGRAMMING A LOGIC DIAGRAM Programming the software

Note: A single Time Switch function block can contain up to 50 programming lines (or ON/OFF
cycles). A program (logic diagram) accepts 356 ON/OFF cycles, i.e. 7 clock blocks with the
maximum number of cycles and 1 clock block of 6 cycles.

Summer time is automatically activated according to the selection mode (see part 2
of this document — * Programming via the module front panel” - to see the relevant specifications.

Entering the first programming line.

According to the specifications, the bell should ring at 07.55, Monday to Friday.
1-From the dialogue box on figure 1.40, click on the Open/New button. The corresponding
dialogue box (figure 1.41) offer three types of programming :
Weekly (choice of one or more weeks per month),
Daily (choice of one or more days of the week),
Calendar (“date’) (choice of a specific date according to a calendar which is
year 2000 compliant (1900 to 2100)).

Daily selection :

If the box is not checked, it is possible to select one or more days
Weekly selection : of the selected week(s).

If the box isnot

checked, itis

possibleto makea Set Time Switch by Week Calendar

selection :

selection by week
(A particular Selection of a
week). [V Everywesk [ Daily By Date.. particular date at

a specific time.

- Specitic W eek MOM  TUE WED THU FRI  SaT  SUN
¥ 1t 7daysist o 7Hi | =2 B "2 R 2 I
e e i e M Setting Time
Jv| Srcd il el Sthn e 21 ] Hour Mir

[ | At T aps{22ndlke 28] IF" ﬂ : |55 ﬂ Q I Selection of the
= =l " DFF time and the
| e e el = e !
- action to be
performed (ON

0K I Cancel | Help | or OFF).

Fig. 1.41

2-Copy the data from figure 1.41 into the dialogue box so that the clock transmits an ON
signal at 07.55 on Monday to Friday every month.

3-Confirm by pressing OK.
Thefirst programming line should be as shown in figure 1.42.

ON 7:55 Mon Tue Wed Thu Fri Every week

Fig. 1.42
In order to be able to send another ON signal to the bell, the first one must be stopped. This should

happen one minute | ater.

S| Crouzet 2
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PROGRAMMING A LOGIC DIAGRAM Programming the software

4-Click on the next blank programming line.

5-In the Weekly Time Switch dialogue box change the time to 0756, and check the OFF
box.

6-Confirm by pressing OK.
The display will be as shown in figure 1.43.

ON 7:55 Mon Tue Wed Thu Fri Every week
OFF 7:56 Mon Tue Wed Thu Fri Every week
Fig. 1.43

Continue in thisway for al the times detailed in the specifications.

Do not forget to deactivate the ON signal each time, one minute later.
The grid should display the following lines (figure 1.44).

ON 7:55 Mon Tue Wed Thu Fri Every week
OFF 7:56 Mon Tue Wed Thu Fri Every week
ON 8:00 Mon Tue Wed Thu Fri Every week
OFF 8:01 Mon Tue Wed Thu Fri Every week
ON 8:50 Mon Tue Wed Thu Fri Every week
OFF 8:51 Mon Tue Wed Thu Fri Every week
ON 8:55 Mon Tue Wed Thu Fri Every week
OFF 8:56 Mon Tue Wed Thu Fri Every week
ON 9:45 Mon Tue Wed Thu Fri Every week
OFF 9:46 Mon Tue Wed Thu Fri Every week
ON 9:55 Mon Tue Wed Thu Fri Every week
OFF 9:56 Mon Tue Wed Thu Fri Every week
ON 10: 00 Mon Tue Wed Thu Fri Every week
OFF 10: 01 Mon Tue Wed Thu Fri Every week
ON 10:50 Mon Tue Wed Thu Fri Every week
OFF 10:51 Mon Tue Wed Thu Fri Every week
ON 10:55 Mon Tue Wed Thu Fri Every week
OFF 10:56 Mon Tue Wed Thu Fri Every week
ON 11:45 Mon Tue Wed Thu Fri Every week
OFF 11:46 Mon Tue Wed Thu Fri Every week
ON 13:55 Mon Tue Wed Thu Fri Every week
OFF 13:56 Mon Tue Wed Thu Fri Every week
ON 14: 00 Mon Tue Wed Thu Fri Every week
OFF 14:01 Mon Tue Wed Thu Fri Every week
ON 14:50 Mon Tue Wed Thu Fri Every week
OFF 14:51 Mon Tue Wed Thu Fri Every week
ON 14:55 Mon Tue Wed Thu Fri Every week
OFF 14 : 56 Mon Tue Wed Thu Fri Every week
ON 15:45 Mon Tue Wed Thu Fri Every week
OFF 15:46 Mon Tue Wed Thu Fri Every week
ON 15:55 Mon Tue Wed Thu Fri Every week
OFF 15:56 Mon Tue Wed Thu Fri Every week
ON 16: 00 Mon Tue Wed Thu Fri Every week
OFF 16:01 Mon Tue Wed Thu Fri Every week
ON 16:50 Mon Tue Wed Thu Fri Every week
OFF 16:51 Mon Tue Wed Thu Fri Every week
ON 16:55 Mon Tue Wed Thu Fri Every week
OFF 16: 56 Mon Tue Wed Thu Fri Every week
ON 17:45 Mon Tue Wed Thu Fri Every week
OFF 17:46 Mon Tue Wed Thu Fri Every week
Fig. 1.44
T|Crouzet| 25

AUTOMATISMES



PROGRAMMING A LOGIC DIAGRAM

Programming the software

Programming the second clock which prevents the bell ringing during school and bank holidays.
7-Double-click on the second clock function block in the programming screen to access the
dialogue box in figure 1.45.
8-Press the Open/New option.

Time Switch

LComment
’7 v Display Comment

¥ Display Signal Numbsr

v Display Meriitor Infarmation

Fig. 1.45

-__3

Delete |

[~
Diaylight S aving Time

Current Time | Summer Time

oK |

Cancel |

Help |

9-Since holidays and bank holidays to be programmed are calendar dates, according to the
specifications, press the date option in the TimeSwitch box (figure 1.46).

Set Time Switch by Week

¥ Everpweek

S pecific ‘week
I st Valawsi st ba v

& | 2 ¥l Eprs Bt b T E
I | S 7y St b ZiE]
¥ Ath v aysE2nd b 25
I Sth VaEysEat e End]

[~ Daily
MOM TUE WED THU  FRI SAT  SUM
[ [ n r - [ [
Setting Time

Hour bdin

= | ™ 0N

i} B (1] =

.

ok |

Cancel | Help |

Fig. 1.46

10-A further box will open (Define the Date Time Switch) from which it will be possible,
once the Date option has been checked (step 1 figure 1.47), to enter these dates using the Calendar

option (step 2 figure 1.47).
1 2
I'I.?.'ISSS LCalendar !

" Ever Year |1 :I |Ju|y j

' Every Month |1 3: By week. .. | :>

Setting Time

Hour Min & 0N

o HoPk H com

Ok | Cancel | Help
Fig. 147

Thu
30 1 2 |3 [4 |5 |6
N = = L b = B

/
v
IDecemher j|1sss j
MonTue [(Wed Fri | Sat |Sun

R

3 Set Time Switch by Date

" Every Year |1 j

E
I‘I 8121998 Calendar |
IJ uly j
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PROGRAMMING A LOGIC DIAGRAM Programming the software

11-Once the calendar is activated, select the year of the first date (18 December 1998 in the
evening, say 20.00, for example). Then, select the month of December, and then the day 18.
12-Confirm by pressing OK (step 6 figure 1.47).
13-Enter the hour, i.e. 20.00 (step 7 figure 1.47) and the command ON.
14-Confirm by pressing OK.
The command line should display the following information (figure 1.48).

ON 20:00 18.12.1998 Date

Fig: 1.48

Now the clock signal needs to be deactivated for the end of the Christmas holidays on 4 January
1999 in the morning at say 05.00.

15-Proceed in the same way as before. The expected result is shown in figure 1.49. Be
careful, this date requires the deactivation command OFF.

ON 20: 00 18.12.1998 Date
OFF 5: 00 4.1.1999 Date
Fig: 1.49

The remainder of the holidays can be programmed in the same way. However, bank holidays which
occur each year on the same date can be recalled by the Every year option in the Define the Date
TimeSwitch dialogue box (figures 1.50 and 1.51).

16-For example, activate the signal on 1 January at 00.00 (figure 1.50) and deactivate it on
2 January at 00.00 (figure 1.51).

Set Time Switch by Date Set Time Switch by Date [ %]
" Date |1.F.1999 Calenear | C Date |1.?.1999 o |
& Every Year 1 = Panuary =] B — Paruay =]
 Every Month m By tw'eek... | " Every Month m By Week... |
Setting Time Ny Setting Time
Hour Min m Haour Min 0N
o H P H o - - @)
kK | Cancel | Help | kK | Cancel | Help |
Fig. 1.50 Sart of bank holiday. Fig. 1.51 End of bank holiday.
The entry should appear as follows (figure 1.52).
ON 0:00 Every Year 1 january Date
OFF 0:00 Every Year 2 january Date
Fig: 1.52
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17-Define al the ON/OFF cycles as shown in figure 1.53.

(" [on 200018121998 DATE
OFF  5:00 41,1939 DATE
ar 2000001221999 DATE
OFF  5:00 [1.31939 DATE

Holidays < o 200005941939 DATE
OFF | 5:00 264159399 DATE
ar 2000 2061993 DATE
OFF B:00 631939 DATE

. |ON 2000 29101599 DATE

/ OFF  5:00 &811.1999 DATE
oM 0:00 |Ewveryyear 1 Januany DATE
OFF | 0:00 |Evenyyear 2 Januan DATE
o 0:00 541939 DATE
OFF 0:00 (641939 DATE
oM 0:00 |Everyyear 1 May DATE
OFF | 0:00 |EvenyYear 2 May DATE
oM 0:00 |Ewveryear 8 May DATE
OFF | 0:00 |Evenyyear 3 May DATE
o 0:00 1351539 DATE

Bank holidays OFF 0:00 145175999 CATE
ar 0.00 2457993 DATE
OFF 0:00 2551759399 DATE
aM 0:00 |Eweryyear 14 July DATE
OFF | 0:00 Ewemrpyear 15 July DATE
oM 0:00 |Eweryyear 15 August DATE
OFF | 0:00 EwemnYear 16 August DATE
oM 0:00 |Everyear 11 Movember DATE
OFF | 0:00 |Ewenyear 12 Movember DATE
oM 0:00 |Everyyear 25 December DATE
\ OFF 0:00 | Everwear 26 December DATE

Programming is compl ete.

Important note : The clock whose parameters have just been set is connected to a NOT logic block
which can be used to reverse the output signal (see logic diagram figure 1.32). In an effort to
maximize memory space, it would have been possible to avoid inserting this block by reversing the
clock signal activation and deactivation commands.
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PROGRAMMING A LOGIC DIAGRAM Programming the software

1.3/ Application 3: Temperature control.

The aim is to control the temperature of a part within a range of 20 and 18 °C. Refer to previous
applications for more details regarding programming.

This requires the use of atemperature/voltage converter (CROUZET Pt100 temperature probe for a
temperature range of —50 to +80 °C (130 degree range) with 0-10V output). The voltage is then
itself converted into adigital value on 8 bitsusing an A.D.C.(Analogue to Digital Converter).

= 130/ 250 = 1 digital value every 0.5 °C
The diagram shown in figure 1.54 illustrates the operation of the system :

temperature 4

_— | Fluctuation dueto
inertia of the
20°C system.
18°C booeee i N __
time
>
heating A
ON 1
time
OFF 0 >
Fig. 1.54

The part is heated to 20°C, then heating is stopped until the probe detects 18°C, then heating
restarts.

Thelogic diagram is as follows (figure 1.55) :

Temperature converted to
digital value: 101

Heating
Gan SCHMITT >

Fig. 1.55 Logic diagram for temperature control.
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=>In the IN menu, select the analogue input (figure 1.56).

) Fig.156

=>Inthe OUT menu, select the Heating output (figure 1.57).

[ Fig. 1.57

=>From the FUNC menu, place the Gain and Trigger function blocks as shown in figure
1.58.

FED TITLE

Ioz

Iaos

I04

Fig. 1.58

=>Connect the blocks :
1-Link the analogue output 101 to the analogue input of the Gain block.
2-Connect the output of the Gain block to the first input of the Trigger block (figure
1.58).
3-Join the output of the Trigger block to the output O01.

S| Crouzet »
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PROGRAMMING A LOGIC DIAGRAM Programming the software

->Set the parameters for the Gain function block.
1-Double-click above to obtain the associated dialogue box (figure 1.59).

Gain
Camment Graph y
{ | 3520 - | Display of the gain curve:
¥ Display C t o
e f *Curve within the upper

[V Dizplay Signal Mumber limit 40 °C, and the lower
Temperature [V Display Monitar Infarmation * x| limit —5°C.
range from—50 | [ Ban: #=(A/EI% ;*Sl ope of gain straight
to +80°C Gain Mumerator (8] = I'I 30 ine = 130/250.

Gain Denorminator (B 250
— 3520

Number of T

‘T

valuesfromthe | —ClampValues ~Scale
8-bit A.D.C. Upper Clamp {
|_1
Lowser Clamp 5 .‘J Ca .\. |

Offset of the Seleqtion of scale for
origin bringing 0K | Cancel | Help | drawing the curve.
the“0” of the \ |

digital valueto

-50°C. Fig. 1.59 \— Vaues limiting the

possible range of

temperatures.

2-Enter the values shown on figure 1.59 :

Using the formulay=(A/B)x + C
C : Offset = -50 (offset of the origin).where x=0: C=y
A : Gain numerator = 130 (temperature range detectable by the probe).
B : Gain denominator = 250.
A/B=(y-C)/x = (80 + 50)/250 = 130/250
Upper limit = 40 (limited to a detection of +40°C).
Lower limit = -5 (limited to a detection of —-5°C).

3-Pressthe Draw key to plot the gain curve.
4-Press OK to confirm the entry.

=>Set the parameters of the Trigger function block. The control zone must be defined.

1-Double-click above to obtain the associated dialogue box (figure 1.60).
2-Enter an “ON to OFF” value of 20°C.
3-Enter an “ OFF to ON” value of 18°C.
4-Press OK to confirm the entry.
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Schmitt Trigger E2
|'Eomment
v [ . .
(el B Gain function block
I¥ Display Signal Mumber connected to the first
¥ Display Monitor Infarmation ana og_ue mpLIt of
the Trigger.
Operated Yalus 74£ /
(BT
Digital values
A defining the control
zone.
0N to OFF Walue OFF to O Walue
[-32 /o E7] [-32 /BT a2 /57
QK I Cancel | Help |
Fig. 1.60

=>Simulate the system by pressing the Start/Stop Simulation (see page 14) or by going to
the Controller drop-down menu and selecting the Simulation and ON option.

-A digital value (temperature analogue data) is entered by clicking once on the analogue
input 101 during simulation (figure 1.61). Enter a value between 0 and 255 in the dialogue box

which appears.

FEL TITLE

Temperature of 20 °C corresponding to the
digital value entered at the input, say 135.

oz
SECIMNOFF|

Data: GaindnalogWal|
74/—_ B0 0N to OFF:Z0
BYG BACTIVE OFF to 0ON:18

1alfEE0)x - EO)

¥ =0
&al=20’

SigAnalog¥al

Cancel |

Fig. 1.61
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Programming via the module front panel

2/ Programming via the module front panel.

The model shown here has 6 inputs and 4
outputs (figure 2.1).

This section explains the various menus
available on the module, and the technique of
programming directly from the 8 keys on the
front panel. The examples which will illustrate
the procedure are very easy.

2.1/ Presentation of the options available. Figure 2.1
During modul e setup, the display is as follows (figure 2.2):
Time display TO&M:HU
< u
Inputs: The 6 circles on the line ( __
represent the 6 inputs. When one N T
i i ProgClear
of them is activated, the | © 000°00 (

corresponding circle is blacked
out. In this example, input 4 (104)

is active. 0 :*000

ﬂ:ig. 2.2 Screen which appears
Outputs. The 4 outputs are when the unit is first switched

shown schematically, like the on. The display is 4 lines of 10
. ’ . characters.

inputs. Here, output 1 (O01) is

active.

Pressing one of the keys leads to the main menu (see figure 2.3).

The prompt (>>) indicates which option can be selected.

Fig. 2.3 Main menu

Note : - A flashing text isready to be selected.

- If akey which cannot be used is pressed, a question mark ( ? ) appears at the top of

the display screen.
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Programming via the module front panel

Key no. Key no. .
(fig?r/e 2.4) (m%ule) Function
1 | ESC K02 Cancels an operation, returns to previous menu.
2 + K03 Increments, used for connecting blocks.
3 - K04 Decrements, disconnects blocks.
4 | OK K01 Accesses a menu, confirms an entry.
5 - K05 Scrolls up.
6 v K06 Scrolls down.
7 ’ K07 Moves to theright.
8 1 K08 Moves to the l€ft.

Fig. 2.4 Key identification.

Each block used occupies a memory space which mainly depends on the complexity of the function.
In aprogram, the memory islimited to 1500 bits, and the number of blocks which can be inserted is

64. The interna bits and the module keys do not occupy any bit. Connections to an output each

account for 10 bits.

The following table summarizes all the function blocks.

Memory
Function Block space Description
(bits)
AND (upto 4 E 19 AND/ Output ON when all the inputs present are ON/ Inputs not connected are
discrete inputs) | e | considered to be ON.
OR (upto4 [=1] 19 OR/ Qutput ON when at least one input present is ON/ Inputs not connected are
discrete inputs) _%_ considered to be OFF.
XOR (2 discrete | =T 13 | EXCLUSIVE OR/ Output ON when asingle input is ON.
inputs) k=4
NOT (1 discrete 1] NOT/ Reverses the signal/ Output ON if input OFF, and output OFF if input
. [ 10
input) | o | ON.
NAND (upto 4 I 19 NOT AND/ Output ON when at least one input present is OFF/ Inputs not
discrete inputs) 4 connected are considered to be OFF.
NOR (upto 4 g 19 NOT OR/ Output ON when all the inputs present are OFF/ Inputs not connected
discrete inputs) | s | are considered to be ON.
BOOLEAN (upto | [ % Can be used to create logic equations between the connected inputs/ It is
4 discrete inputs) possible to test the equation.
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PROGRAMMING A LOGIC DIAGRAM Programming via the module front panel

& Bistable memory/ Output activated by SET (discrete input), deactivated by
SET/RESET & 14 RESET (discrete input)/ Priority assigned either to SET or RESET.
Delays asignal (discrete) from arising edge, from a faling edge, or both at the
DELAY 19 same time/ Possibleto RESET (discrete input)/ 1 digital output (value).

Sends an impulse signa which can be reset/ Conditions for removing the
17 discrete output : deactivation of the discrete input or end of delay/ Possible to
RESET (discrete input)/ 1 digital output (value).

Sends a pulse from arising edge, from afalling edge, or both at the sametime/ 1
discreteinput/ 1 discrete output.

Impulse relay function/ Alternates the output signal (discrete) on each rising

ONE SHOT

PULSE 11

FE

Counting incremented on each rising edge of the input (discrete)/ Possible to

COUNTER 16 RESET (discrete input)/ Preset value can be assigned by a digital value/ 1
T discrete output/ 1 anal ogue output.

Counting incremented (discrete input), decremented (discrete input) on each

rising edge/ Preset value can be assigned by a decimal value (parameter) or by

an analogue input/ 1 discrete input to obtain the preset value directly/ Possible to

RESET (discrete input)/ 1 discrete output/ 1 analogue output.

ALT 13 edge of the input (discrete)/ Possible to RESET (discrete input)

UP/DW

COUNTER 22

Sends a train of impulses (set ON, set OFF) according to various modes:
19 ON/OFF cycle counting (preset), time counting (preset), continuous/ 1 discrete
input/ 1 discrete output/1 digital output (value).

Compares two analogue or digital quantities if the discrete input is activated (by
default, the pin is considered to be active)/ Activates the discrete output if the
equation is verified/ (If thereis no connection on the analogue pins, two decimal
values will be compared.)

FLICKER

COMPARE 17

Program clock/ Uses the module internal time and date to activate or deactivate
** the discrete output/ Daily, weekly, calendar timetables/ Year 2000 compliant/
Manages Summer time/ 356 ON-OFF cycles.

TIME SWITCH

Can be used to convert an analogue value by changing the scale and offset/
GAIN 22 Parameters : gain numerator, gain denominator, FB offset (offset of the origin),
upper and lower conversion limity 1 discrete input/ 1 analogue input. 1 digital
output (value).

Defines an activation zone with hysteresis (ON value, OFF value) of the discrete
19 output/ The function can be performed if the discrete input is active (by default,
the pin is considered to be active)/ 3 analogue inputs.

SCHMITT

Defines arange (digital or analogue values) in which activation (or deactivation
20 according to the option checked) of the discrete output is a function of the value
used/ 1 discrete input/ 3 analogue inputs.

ZONE
COMPARE

- Displays digital, analogue data, character strings, date, time, messages for the

DISPLAY man-machine interface.

T Time counting (preset hour, minute) during each activation of the discrete input/
HOUR METER Ll 19 Elapsed time memory/ Possible to RESET (discrete input)/ 1 discrete output/ 1
digital output (value).

* 19+ 1 x (term in the equation)
** 8+ 4 x (number of ON/OFF cycles)
*** - 13 + 1 x (each character displayed on the screen)
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2.1.1/ Main menu : MainM enu.

2.1.1.1/ Run:Executes a program (figure 2.5).

=>Press OK to access the following display (figure 2.6).

=>The OK key executes the program, the ESC key cancels the
selection and returns to the previous menu.

OK ESC

Fig. 2.6

Note : The program is running when three small vertical bars flash at the top of the screen (figure
2.7).

Fig. 2.7
2.1.1.2/ Stop:Stops a program.

When a program is in Run mode, the Stop mode is activated in the main menu. It will then be
impossible to edit or clear a program.

=>From the main menu (figure 2.8), place the Stop option next to
the prompt.

Fig. 2.8

->Press OK to confirm the selection.
=>Now there are two choices (figure 2.9): either confirm with OK,
or cancel the procedure with ESC.
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2.1.1.3/ Monitor:Display of thelogic diagram during execution.
When the program is launched (check this by making sure that the
small vertica bars are flashing at the top of the screen), the
Monitor mode appears in the main menu (figure 2.10).

Fig. 2.10

->Select the Monitor option, and press OK. Part of the logic
diagram is displayed (figure 2.11). Keys5(*),6 (™), 7 (" ), and
8 () can be used to scroll through the rest of the diagram.

Fig. 2.11

=3The ESC key returns to the Edit menu which contains three
options (figure 2.12) :

Fig. 2.12

-ProgSze (figure 2.13) : Views the module€’ s memory capacity, that is
the number of function blocks and the percentage of memory used.

-Jump (figure 2.14) : Use this option to arrive at a particular block.
Internal bits (M :SystemBit M01~MO05), inputs (I :Input 101~104 or 106 or 112), outputs
(O :Output O01~002 or O04 or 008), front panel keys (K :Key K01~K08), and blocks
(B :Blocks created by the user) can be accessed by the ¢ and *» keys. Keys 2 (+) and 3 (-) select
a block for each category. Access to the block is confirmed with OK, ESC returns to the main
menu.

-Exit (figure 2.15) : Quit the Edit mode to return to the main menu.

Monitor

Fig. 2.13 Fig. 2.14 Fig. 2.15
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In Monitor mode, it is possible to identify the status of a block (ON or OFF). When the output is
ON, asolid vertical rectangle appears under the block number (figure 2.16).

Input 101 : ON }—\ /—{ Output O04 : ON

1 04
I 1\ Theinput of O04 is
| Out

connected to 101
n S
which is currently

Fig. 2.16 Programming screen. ON.

2.1.1.4/ ProgEdit: Programming alogic diagram.
=>Select the option as shown in figure 2.17.

TopMenu.
Run

=>=

ProqClear
Fig. 2.17

=>Press OK to access the corresponding menu.
=21t is now possible either to record a new program, or to modify an existing program.

Note : Details regarding connection and programming can be found in the description of application
examples.

linside the ProgEdit mode, it is possible to access an Edit Menu submenu by using ESC to leave
the programming screen (this will be explained | ater).

2.1.1.5/ ProgClear: Clears aprogram.
=>Position the option next to the prompt (figure 2.18).

TopMenu.
ProgEdit

>=

ClockSet

Fig. 2.18

=>Press OK to access the following panel.

=>Figure 2.19, it is possible to confirm deletion with OK, or to Program
return to the main menu with ESC.
Clear
Or
Fig. 2.19
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2.1.1.6/ LANGUAGE: Selects the lanquage.
=>From the main menu (figure 2.3), use keys 5 (#) and 6 () (figure 2.4) to scroll through the list
of options.
=>Position the LANGUAGE option next to the prompt (figure 2.20)

LANGUAGE

Fig. 2.20

=Press key 4 (OK). The LANGUAGE menu then appears (figure 2.21).

English French LANGUAGE

Fig. 2.21 Fig. 2.22 Fig. 2.23

-2Usekeys5 («) and 6 (™) again to select alanguage (figure 2.22).
=>Press key 4 (OK) to confirm the selection.
=>Exit the menu using key 1 (ESC). Return to the main menu (figure 2.23).

2.1.1.7/ Clock Set: Sets the time and date:
=>From the main menu (figure 2.23), scroll through the list using keys 5 («) and 6 () until the
prompt is opposite the Clock Set option (figure 2.24).

ClockSet

Fig. 2.24

->Presskey 4 (OK) to access the corresponding menu.

=>The screen in figure 2.25 shows the status of the time and date setting. There are three display

modes for the date : year/month/day < yyyy/mm/dd (figure 2.25)
day/month/year = dd/mm/yyyy (figure 2.26)
month/day/year = mm/dd/yyyy (figure 2.27)

Each mode is activated from line 2 (yyyy/mm/dd or dd/mm/yyyy or mm/dd/yyyy) by pressing

either key 2 (+) or key 3 (-).

yyyy/mm/dd dd/mmlyyyy mm/dd/yyyy
Fig. 2.25 Fig. 2.26 Fig. 2.27
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->Example: Today is 31 March 1999 at 10.17. We want to enter the date using the day/month/year
mode. Programming is performed as follows (use keys 5 («),6 (¥),7 (*),8 (1) to navigate
through the screen ; keys 2 (+) or 3 (-) to increment / decrement) :

Fig. 2.29 Setting the month. Fig. 2.30 Setting the year.

-> ->
17

Fig. 2.31 Setting the time. Fig. 2.32 Setting the time. Fig. 2.33 Setting the time.

Fig. 2.28 Setting the day.

The OK key confirms the entry and returns to the main menu.

2.1.1.8/ Others: Accesses other options.
=>Press OK to access the following options : Version, Passwd (password), MenuKey (menu key),
Summer (Summer time), InitModem (initialize modem).

2.1.2/ Submenu : Others.

2.1.2.1/ Version: Module version:
=>From the main menu, select the Other s option (figure 2.34).

Others

Fig. 2.34

=>Press OK to confirm the entry.
=2Using keys5 («) and 6 (), position the Version option next to the prompt (figure 2.35).
=>Press OK to display the product version number (figure 2.36).

Version Ver 1.10
Fig. 2.35 Fig. 2.36
—>ESC returns to the previous menu.
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2.1.2.2/ Pass No.:Enters a password: When a program has

been edited, the pass No. protects access. It can only therefore be | Others
changed if the pass No. is correctly entered. .
Version
Menu Key
Fig. 2.37
->From the Others menu (see figure 2.35), in the main menu, select
the Pass No. option with keys5 («) and 6 (™) (figure 2.37). Setup
Pass No.
000
Fig. 2.38

=>Press OK to access this menu (figure 2.38).

=>The Pass No. contains 4 figures. Enter each one using keys
7(")and 8 () toselect them, and keys 2 (+) or 3 (-) to increment/decrement.

=>Press OK to confirm the entry, or ESC to exit the menu without saving the code.

=>A symbol representing akey (@ ) is displayed at the top of the screen to confirm that it has
been recorded.

Deleting a password: Thisis not possible unless a password has aready been saved.

=>Return to the Pass No. menu. The display will be as in figure
=
2.39.
Cancel
Pass No.
000
Fig. 2.39
=>Now simply retype the saved code and press OK to confirm cancellation.
=>If the code to be deleted is not correct, an error message (figure
2.40) will be displayed. —

=>Press either OK or ESC to return to the Other s menu.

-»Repeat the processif the operation failed. Fig. 2.40

Note: -Deleting a program also del etes the secret code associated with it.
-A secret code can also be entered without having previously edited a program. In
this case, this provides exclusive access to program editing.
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2.1.2.3/ Menu K ey:When the eight keys are used in the program, i.e. assigned to a particular
function, it is possible to exit RUN mode, if desired.

=>From the Others menu, use keys 5 («) or 6 () to position the Menu Key option next to the
prompt (figure 2.41).

Menu Key

Fig. 2.41

=>Press OK to confirm.
=>Themenu in figure 2.42 is displayed.

OK + ESC
Key

Fig. 2.42

=>Selecting OK + ESC Key stops a program even if al the keys on the
panel are used for an action. While the program is running, press the OK
and ESC keys ssimultaneously. Return to the main menu (figure 2.43).

Fig. 2.

Fig. 2.43

\ Fig. 2.45

->Press OK to access the following menu (figure 2.44), or ESC to return to the 1/0O display mode
(figure 2.45).

=>From the menu shown in figure 2.44, it is possible either to return to the main menu by pressing
ESC, or to stop the program definitively (figure 2.46).
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->Selecting the Not Use option (figure 2.47), no longer enables the
program to be stopped, even if al the keys are used.

Fig. 2.47

=>To stop the program running, it is necessary to : -switch the modul e off;
-press OK and ESC simultaneoudly;
-switch the module back on by holding
down both keys for approximately 2 seconds.
=>The screen in figure 2.48 is then displayed for several seconds.
->Press OK to stop the program and return to the main menu.

Fig. 2.48

2.1.2.4/ Summer Time: Select the type of parameter-setting for Summer time.
This menu contains 6 options: Cancel, ManualOn, Date Type,
UK Type, US Type.
When Summer time is active, an “S’ appears on the screen next to
thetimein 1/0O display mode, as shown in figure 2.49.

Fig. 2.49

Cancel (figure 2.50): Deactivates Summer time. The “s’

di .
ISPPEATS Cancel

Fig. 2.50

MA man (figure 2.51): Sets Summer time. The “S’ appears
in 1/0 display modeif it is the time of year to change the hour.

ManualOn

Fig. 2.51
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Typ. Date (figure 2.52):
Updates the start and end dates of
Summer time, as well as the number

of minutes to add to the current time

Date Type (figure 2.53). Line 2 is the start date

of Summer time. Line 3 is the end
Fig. 2.52 Fig. 2.53 date of Summer time.

The « ¥ *» < keys navigate around the screen with the “+” and “-” incrementing or decrementing
each number. OK confirms the entry, ESC returns to the previous menu without creating any
modifications.

UK type, US type, EU type
(figure 2.54): Three types of
Summer time are pre-programmed.
Select one of them by placing the
required type next to the prompt
using the « and ¥ keys.

The recorded dates ae as
follows:

Fig. 2.54

UK type: Last Sunday of March to the first Sunday of November.
UStype: First Sunday of April to the last Sunday of October.
EU type: Last Sunday of March to the fourth Sunday of October.

2.1.2.5/ M odeml nit: Sets the modem parameters.

Command
Modeminit
DelayTime

Fig. 2.55 Fig. 2.56 Fig. 2.57

2.1.2.6/ ProgTran::This option can only be accessed when the EEPROM memory cartridge
isinserted in the module.

ProgTran

Fig. 2.58
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2.1.3/ The program editing menu : Edit Menu.

This mode operates from the ProgEdit option in the main menu.
To access the edit menu, the programming screen must first be
exited (figure 2.59). -

Press ESC to go to this mode. Fig. 2.59 Programming soreen

2.1.3.1/ ProgSize :Memory used. (see paragraph 2.1.1.3).

2.1.3.2/ Jump :Accessto ablock. (see paragraph 2.1.1.3).

2.1.3.3/ New FB :Continue programming from a new block.
=>Select option as shown in figure 2.60.

Edit Menu
Jump

=>=

Exit

Fig. 2.60

—>Press OK.
—->All the functions pre-programmed in the FB Select mode are available. Either select one of them
using the < ,~ keys, and OK to confirm ; or cancel this option by pressing ESC.

2.1.3.4/ Exit :Return to the main menu.

2.1.3.5/ Mnemonic :Gives alinear outline of the logic diagram.
Return to the programming screen by pressing OK or ESC.

2.1.4/ Menu relating to function blocks.

This menu (figure 2.62) can only be accessed from the programming screen, by positioning the
cursor on ablock (figure 2.61) and pressing OK.

Block number. Name of function block.
K
i BO1: DL
o1l & Setup FB
- Indi —
at
id;tilfyir?gr;a Delete FB
function whose

; . parameters can Fig. 2.62
Fig. 2.61 Programming screen. be st
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2.1.4.1/ Setup FB:Parameters specific to the selected function block.
This option will only appear in the menu if the block has a parameter-setting indicator (figure 2.61).
Refer to the section which explains this function to see which parameters may be modified.
=>Press ESC to cancel, or OK to confirm the entry.

2.1.4.2/ Change No :Assigns a different block number.
When a block number has not already been used, it is possible to assign it to another block by using
this option.
=>Select the Change No option then press OK.
=>The screen in figure 2.63 will be displayed.

) — Choice of

Change No block no.
v B01 _
Block number Ny = P Function name

A/ corresponding to
selected. Alternate the new number.

Fig. 2.63

—=>Keys «, ¥, or “+",“-", enable the new number to be selected.

Note : A new block number isfree if Not Exist appears at the bottom of the screen.

=>0OK confirms the selection.

2.1.4.3/ Delete FB :Deletes a block.
This option deletes the block selected in the programming screen.
The menu appears as shown in figure 2.64.

Delete
B64

Alternate
Or

Fig. 2.64
=>Press OK to confirm deletion, or ESC to cancel the operation.

Note : Deleting a block also deletes al the connections to this block.
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PROGRAMMING A LOGIC DIAGRAM Programming via the module front panel

2.2/ Example 1 : Temporary/permanent lighting.

The example shown could apply to lighting a stairwell.

Operation : =>The light switches on for 1 minute when the pushbutton is pressed.
=>The light stays on continuously when the pushbutton is pressed for at least 2
seconds.
=>The light goes out when the pushbutton is pressed for 2 seconds during
continuous lighting.

/O table:

INPUT OUTPUT
11 | Pushbutton O1 |Light

For this example, select amodule with 4 inputs and 2 outputs.

The corresponding logic diagram is shown in figure 2.65.

Pushbutton 11

p» ONE

o » ON L IAIT

sHot | L, LIGHT

OR | >

DELAY

Fig. 2.65 Logic diagram for lighting a stairwell.

The main pointsin this example are :

-time delay (DELAY function),
-time-delayed impulse signal (ONE SHOT function),
-bistable signal (AL TERNATE function).

2.2.1/ Editing the program.

=>From the main menu, select the ProgEdit option.
=>The display suggests starting the program with input 101 (figure 2.66).

Fig. 2.66.
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Programming via the module front panel

2.2.1.1/ Connections between blocks.

=>Connect the ONE SHOT block to the input 101 (pushbutton) :

Pushbutton 101

In

The block number
flashes; here the block 101 is
selected. Keys ‘and *» scroll
through blocks to the right or
| eft.

Keys + and — select a
block from the following:
Inputs, Outputs, Front Panel
Keys, Internal Bits.

Boolean

Complete list of
available functions. Use
keys4 and ¥ to scroll
through.

ESC returnsto the
previous screen. OK confirms
the selected function.

Return to the
OneShot function and confirm
with OK.

D e

o

= [

p  ONE
SHOT

The line on theright
of the block flashes : the
connection can be made.

When the connection
line flashes, the + key can be
used to show all the functions
which can be connected to the
block. Keys 4 and ¥ scroll
throught the list.

Theflashing “1” and the word
Connect indicate that the connection is
ready to be made. Keys“ and ¥ select the
position of the designated link with “ >" .

Press OK to complete the operation
(Connect disappears).
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The ONE SHOT block is now connected. It is numbered BO1 by default since it is the first block
inserted in the program.
=>Connect this block to the OR logic block in the same way as before.

Pushbutton 11
BO1

» ONE

SHOT | |,

OR

20 e 2D

To make a connection after Call up thelist of functions
ONE SHQT, position the using the AddFB option to
cursor on the connection line find the OR logic function.
(which should then flash)
using the

< and » keys.

‘ B ‘-

Input pins (4 for logic Usethe“ and ¥ keysto
functions) are selected using access the OR function.

the4 and ¥ keys.
—1
o T

Make the connection to pin 1,
for example.
Once the
connection is
made, the OR block
isassigned number
T|Crouzet 49
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Note : A black triangle on ablock input indicates a connection has already been made.

=>Connect output O01 to the OR function which has just been incorporated in the program.

Pushbutton 11
BO1
»| ONE B0O2
sHoT | |, R LIGHT

v S

Keys ¢ and » move block Output O1 should now be
BO2 up to the connection line selected using the4 and ¥
which should then flash. keys.

‘ : ‘ -
The connection has been Block O01 is now ready to be
made. connected.

=>Return to input 101, and continue programming from this block using the Jump function.

1-Press ESC to exit the programming screen and access the Edit
Menu (figure 2.67).

Fig. 2.67
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PROGRAMMING A LOGIC DIAGRAM Programming via the module front panel

2-The « and ¥ keys can be used to reach the Jump option. Press OK when this has been
done. (Refer to paragraph 2.1.1.3 to see this menu).
3-Moveto theletter | (Input) using the ¢ and * keys (figure 2.68).

Fig. 2.68
4-Usethe“+” or “-" keysto display input 101.
5-Press OK.
The screen in figure 2.69 will appear and block 101 will flash.

Block BO1 is

aready
connected.

Fig. 2.69

6-Move the block using the ¢ or » keys so that the connection line of block 101 flashes
(figure 2.70).

Fig. 2.70

7-Pressthe “+” key to make anew connection.

Adding an ON DELAY function block.

Pushbutton 11
BO1
¢ » ONE | 5oz
SHOT .
OR
LIGHT
————» ON
DELAY
<|Crouzet 51
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= D « D

A new connection is made Selecting the Delay function.
fromblock 101.
OK

- B -

The connection is made. The connection isready. The
new block is numbered B03.

Delay

=>Add anew function : Alter nate.

Pushbutton 11
BO1

B0O2
® p ONE

SHoT _l—b LIGHT

OR | >

BO3

o » ON L pIAT
DELAY

The steps to be followed are exactly the same as before,
except that the Alternate function block will be selected. The new
block that is created will have the number BO4.

Alternate

Selecting the Alternate
function
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PROGRAMMING A LOGIC DIAGRAM Programming via the module front panel

->The remaining connections are to be made on the existing blocks, i.e. the One Shot and OR
functions.

Pushbutton 11
BO1
B02
[ » ONE |
SHOT _l—b LIGHT
OR >
B0O3 B0O4

o » ON L HIALT
DELAY

20 % 2D

—C
Usethe “ and ¥ keysto Connection is made to the
access the BO1OS block (block inhibit pin of the One Shot
1 One Shot). function block (marked “C").

¢
y

The connections are complete.

=>Make the last connection between blocks B0O4 and BO2.

To do this, use the ¢ and ?» keys to reposition the cursor on block B04, or use the Jump
command and call block BO4.
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Pushbutton 11
BO1

B02
¢ p ONE

sot | L, LIGHT

OR >

BO3 BO4 >

o » ON | SIAT
DELAY

The connection procedure is exactly the same as before. Simply select block BO20OR using
the « and ¥ keysthen select, using the same keys, the three pins that are still available on the OR
block.

Confirm the selection by pressing OK.

2.2.2/ Setting the function parameters.

As soon as the program is complete, you must enter, inside the function blocks whose
parameters can be set (those which have the @ marker), the information necessary for correct
operation at the Millennium.

The only functions for which thisis necessary are the One Shot and Delay functions.

->The time delay intended for temporary lighting corresponds to the One Shot block (BO1). The
duration is set for 1 minute.

1-From the programming screen, return to the Edit menu using the ESC key.

2-Using the Jump command, call block BOL.

3-Press OK.
4-Now follow the instructions as shown in the following diagram :
BO1:0S BO1:0S
D OK D OneShot
Change No
Option for setting parameters Select the Priority option
of the BO1 One Shot block.

The One Shot output —\
will only go to OFF if
the time has el apsed. 01:0S

Priority < i OK

The output goesto RS>
OFF when the input \

also goes to OFF or |nDUt
when theinput is at L
ON and the time has Priority isgivento
elapsed. the time. OK to confirm.
T|Crouzet| 54
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5-Return to the parameter-setting menu and select the OneShot option.

OneShot

OneShot , OK ,

60.0

Select the Priority option

Set thetime T to 60.0s.

OK

=>Setting the parameters for the Delay block (BO3DL ) which activates continuous lighting.

1-Press ESC to return to the Edit menu.

2-Using the Jump command, call block BO3.

3-Oncein program edit mode, press OK.

4-Now follow the instructions as shown in the following diagram :

OnDelay

Setup FB , > ,

Option for setting parameters Select the OnDelay option
for BO3 Delay block.

Y ‘ OK

Thistime corresponds to the
time after which the output
goesto ON (activation delayed
by 2 seconds). OK to confirm.
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OffDelay D o D

Select the OffDelay option

5-Return to the Edit menu by pressing ESC.
6-Select the Exit option using the < and ¥ keys.

The program is ready to be executed.

Thistime corresponds to the
time which should elapse
before the block output goes to
OFF (deactivation delayed by
0 seconds). OK to confirm.

S| Crouzet

AUTOMATISMES

56



	1/ Programming the software.
	1.1/ Application 1 : Access management – Automation of a gate.
	1.2/ Application 2 : School bell.
	1.3/ Application 3 : Temperature control.

	2/ Programming via the module front panel.
	2.1/ Presentation of the options available.
	2.2/ Example 1 : Temporary/permanent lighting.


